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Installation/User’s Guide 

1. INTRODUCTION 

Welcome to TESCO Device Manager (TDM), your complete data management solution.  

TDM is the desktop software platform used to interface with supported TESCO devices. It allows the 

user to connect to supported equipment, synchronize database records, run supported workflows, 

review results, manage device preferences, and generate reports.   

TDM is designed to streamline data management for your TESCO devices. Working with 

TDM makes it quick and easy to extract, organize, and analyze essential metering information.   

  

What Can TDM Do for You?  

With TDM, you can:  

✓ Manage Data with Ease—Extract data from multiple TESCO devices simultaneously.  

✓ Import and Organize—Quickly import meter, site, and charger information from CSV files.  

✓ Export Test Results:  

• Generate PDF reports with custom branding, unit conversions, and chart/graph color 

adjustments.  

• Export results in CSV format for easy data analysis.  

• Create custom exports using SQL queries and regular expressions.  

✓ Update Multiple Devices at Once—Save time by updating TESCO units simultaneously.  

✓ Remote Control Meter Test Boards—Manage test boards through a secure network link.  

For over a century, TESCO has been a trusted name in metering, delivering accuracy and reliability. With 

TDM, managing your devices has never been easier.   

  

TDM Supported Devices   

TDM supports the following device groups:  

• NextGen Meter Test Boards including Cat. Nos. 2199, 2990, 3200, 3050. 

• Meter Site Analyzers including Cat. No. 6330.  

• Turbo Tester Cat. No. T3.  

• EVSE Testers including Cat Nos. T4000, T4350. 

• Knopp Comparators including Cat. Nos. KATC-C2, KATC-V2, KCTS-8000X.  

• KCTS-8000XA, the new automatic extended range Knopp Comparator.  

http://www.tescometering.com/
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TDM Device Support Matrix  

The capabilities available in TDM depend on the device that is connected and the 

testing function being performed:  

  

Device Name  DB Sync  

Update 

Software  

Remote 

Tests  

View Results / 

Export Reports  

Remote 

Screen  Calibration  

Meter Test Boards  

(NextGen)  
✓  ✓*  ✓  ✓  ✓  ✓  

Meter Site Analyzers  ✓  ✓    ✓  ✓  ✓  

Turbo Tester (T3)  ✓  ✓    ✓  ✓    

Knopp Comparators        ✓  ✓    

EVSE Testers  ✓  ✓    ✓  ✓  ✓  

KCTS-8000XA  ✓  ✓  ✓  ✓  ✓    

  

Function Definitions  

DB Sync  

Synchronize supported records, test data, and related device information between TDM and the 

connected unit or database.  

Update Software  

Automatically update the software or firmware version for applicable devices.  

*Some NextGen devices running older software may need manual upgrades. If the latest version of 

TDM advises an assisted upgrade, please contact your TESCO representative.   

Remote Tests  

Start, control, and monitor supported metering workflows through TDM.  

View Results / Export Reports  

Review completed test results in TDM and generate documents in PDF and CSV formats.  

http://www.tescometering.com/
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Remote Screen  

View and interact with the device screen through TDM when remote access is activated.  

Calibration  

Allows access to calibration tools and workflows, including device-specific functions. Options including 

Standard Validation, RD Calibration, Fluke Calibration, AC Calibration, and DC Calibration may be 

available, depending on the device type and TDM configuration.  

  

Notes  

• The range of functions available may depend on the device and the current TDM release.  

• Some workflows may require a specific TDM version, and in particular those for newer devices.  

• Refer to the relevant sections in this manual for detailed device-specific instructions.  

 

2. CONTACTING TESCO 

For Technical Support or Calibration/Repair, please call +1 215.228.0500. 

You can also send an email to support@tescometering.com with any questions.  

To view, print, or download the latest manual supplement, visit tescometering.com.  

 

3. INSTALLATION 

To download TESCO Device Manager (TDM) click here: 
https://www.tescometering.com/software/tdm/ or go to:  tescometering.com, click 
resources, download TDM, scroll to the bottom and click on Download TDM Here. 
 
After downloading you can start installing, by running TescoDeviceManager_Setup.exe. 
 

An installation wizard will pop up to guide you in the installation process. 
 

Note:  

• The installer will only run on Windows 8, 10 & 11. 

• Administrative rights are not required to install the application. 
 
 
 
 
 

3.1 Installation Steps 

http://www.tescometering.com/
mailto:support@tescometering.com
http://www.tescometering.com/
https://www.tescometering.com/software/tdm/


 

 
 

 

Installation Guide 

    tescometering.com                     +1 215 228 0500

                support@tescometering.com 
4 

SCREEN DESCRIPTION 

STEP 1: Welcome screen   

  The software version of the TESCO 
Device Manager application that is 
about to be installed is indicated on this 
screen, along with the software versions 
of the TESCO Devices that this version 
TDM supports. 
 
Press “Next >” to proceed with the 
installation. 
 
Choices Are: Extract All/Run/Cancel 
 
Select: “EXTRACT ALL” 

    

STEP 2: Installation Directory   
 

The default installation directory of the 
application is: 
 

C:\TESCO\TescoDeviceManager 
 

The user can change the installation 
folder by clicking the ellipsis button and 
browsing the desired directory.   
 

Note: When installing a new version, be 
sure it uses the same path as the current 
one to ensure that it will overwrite it. 
 

“Next >” to continue with the 
installation. 

    

STEP 3: Selection of Application Components   

  The information on the required disk 
space to install the application is 
provided. 
 
Press “Next >” to continue with the 
installation.  
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SCREEN DESCRIPTION 

STEP 4: License Agreement    This screen contains the license 
agreement in using TESCO Device 
Manager.  

  
 

 

 

 

 

 

 

 

 
 

After accepting the terms, the 
installation process can continue. Press 
“Next >” to proceed to the next step. 

  
 
  

  

STEP 5: Start Menu Shortcut   

  
 
 
 
 
 
 
 
 
 
  

In this screen, you can change the Start 
Menu shortcut location for TDM. 

    

  

X 

X  

 

http://www.tescometering.com/


 

 
 

 

Installation Guide 

    tescometering.com                     +1 215 228 0500

                support@tescometering.com 
6 

SCREEN DESCRIPTION 

STEP 6:  Begin Installation 
 
 
 
 
 
 
 
 
 
 
  

Press “Install” to confirm and start the 
actual installation process. 

  
 

    

STEP 7: Installation in Progress 
 
 
 
 
 
 
 
 
 
 
  

This screen shows the progress of the 
installation process. 
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SCREEN DESCRIPTION 

STEP 8: Successful Installation   If no errors are encountered during the 
installation process, this step will show 
up and indicate that the installation is 
successful. 
 
Press “Finish” to successfully end the 
installation.  
 
Note:  
The application is now ready to be used 
and does not require a computer restart. 

 

Once the installation is complete, launch the software by double clicking the TDM icon to access the 

login screen.  

Simply press “Enter” to log in.  

 

4. USER INTERFACE 

The main user interface includes: 

• Toolbar at the top 

• Side navigation menu for easy access to features,  

• Workspace area where you can efficiently perform tasks 

The Toolbar is broken down into four sections: 

1. File: 

a. Migrate TMA 

b. Sync with Network Database 

c. Remote Control 

d. Quit 

2. Edit 

3. Management 

4. Help 

For those currently using TESCO’s TMA software, please start here. Other users skip to section 

4.1.2/EDIT. 
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4.1 Menu Bar 

4.1.1 File 

 

 

Under File menu, we have 4 items:  

 

1. Migrate TMA data - This is a one-way operation which copies the data from older 

database versions (i.e., Test Management Application) to TDM.  

 

2. Sync with Network database - This is a two-way operation which will make both 

TDM and Network databases up to date with each other. All new records in TDM 

will be copied over to the Network database and all new records in the Network 

database will be copied over to TDM. New records also include records that have 

been marked as “Dirty”.  

 

3. Remote Control - Launches the Remote Control Utility from within the app. This is 

a one-way action (TDM just starts the external tool).   

 

4. Quit – Close the application. 

 

4.1.2 Edit 

 

 

 

Edit has one item under it titled Preferences.  Under Preferences there are five different 

tabs (General, Database, Report, User Interface and Others) that will enable the end 

user to customize TDM, so it is exactly the way they want it to be. Section 5, Setting Up 

Preferences will walk you through that process. 
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4.1.3 Management 

Under the Management tab, end-users can customize settings and configurations, giving them 

advanced control and customization options to optimize their experience and enhance system 

functionality. 

The Management section displays a list of supported equipment.  However, the devices shown may not 

all apply to your setup. You will only need to configure and manage the equipment specific to your 

installation. If a device is listed that you do not own, you can simply disregard it. 

 

NextGen – Standards Validation 

This is where you can compare measurements from a Meter Test Board based on RD-2x/RD-3x, or a 

Pulse Processor setup with 3 RD-2x.  

Device Under Test (DUT). The device in which you are testing. 

Test points: Test points can be added on the fly in the matrix; right click to add or delete rows. By 

clicking save test points, the system will automatically save an excel spreadsheet to the folder that is 

defined in “Output” path.  If you prefer working or editing in Excel you are able to do so; once the 

document is saved, the system will automatically pull that information into TDM. 
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              Communications (Comms). Select the device you will be communicating with. 

Communications (Comms) refers to how the test system receives data from the meter. Users can 

select from three options: None, RD (Radian) for standard reference communication, or Pulse Processor 

when using a dedicated pulse counting device. 

                   

Measurement Type. Choose from kWh, kVARh or kVAh. 

 

Output.  Path in which reports will be exported. 

 

 

Status. Status is a free-form text field that allows users to enter notes or context related to the test 
session. This field is optional and can be used to document conditions, observations, or internal tracking 
details. 
Examples of how the Status field might be used: 

• Noting environmental conditions (e.g., “High humidity in test area”) 
• Indicating meter condition (e.g., “Meter requires re-inspection”) 
• Logging operator initials or shift details (e.g., “Checked by PM – Night Shift”) 
• Adding a reminder or flag for future review (e.g., “Review kVARh drift”) 

  

 

CAT. 6330 – Fluke Calibration 

Calibrate the TESCO 6330 Meter Site Analyzer with a Fluke 6105A. 

Device Under Test (DUT). 

DUT Serial #.  Drop down menu will populate based on device attached. 

Software Revision: Version will populate based on device. 

Last Calibrated: Date will populate based on device. 

Fluke.  Information pertaining to the fluke device. 

/Meter Shop/Documents/TDM-Reports  
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Communication Port: Use drop down to select, Model and Serial # will populate based on 

device attached. Click “Read Info” 

Others. Enter the room humidity and temperature. 

Output.  Path in which reports will be saved. 

 

EVSE – AC Calibration 

Conduct AC calibration on an EVSE Tester with TESCO ACTM. 

 

 

 

 

 

 
 

 

 Not sure how to do it?  

Click Help to access AC Calibration Cable Setup Guide. 
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1. EVSE – DC Calibration 

       Conduct DC calibration on an EVSE Tester with a TESCO DCTM. 

 

 

           

 

 

 

 

 

 

Not sure how to do it?   Click Help to access AC Calibration Cable Setup Guide. 
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Custom Query   

End-users can create and run custom SQL queries within the TDM database offering meter shops 

enhanced data management, reporting and efficiency. 

 

Custom Exports 

Custom exports in TDM allow users to create custom export scripts by leveraging a combination of SQL 

queries and Regular Expressions (RegEx) to extract, filter, and format data in a highly tailored way. 

 

Harmonics 

Create custom waveform based on harmonics. Build your own library of voltage and current harmonics 

based on amplitude and phase. 
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4.1.4 Default Settings Popup  

The Default Settings give users the ability to set custom default settings. 

4.1.4.1 Form Default 

The system allows you to configure custom default settings for a meter if desired. Custom defaults are 

easy to recognize, as they appear in light purple text. Setting default values for a Meter form helps 

streamline workflows, reduce errors, and improve overall efficiency. 

This Default Form is used to define the values applied to Meter Forms across all TDMs. When you create 

a new Meter Form and select this form in the popup, the meter values will automatically be populated 

with the defaults configured here. 
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4.1.4.2 CUSTOM AEP CODE  

 

 

 

 

 

 

 

 

 

 

 

This Custom AEP Code tab is used to create and manage Custom AEP Codes. A Custom AEP Code allows 

users to save a specific set of meter information so it can be reused later with an SN. 

At the top right of the window, a dropdown displays all previously saved Custom AEP Codes. Selecting a 

code from the list will load its saved meter information into the fields below. 

Next to the dropdown, a status message indicates whether the selected code is already saved or 

currently overriding the default AEP code. 

The remaining fields in the popup allow users to enter or edit the meter information for the selected 

Custom AEP Code. These include Form, Kh, TA, Voltage, Multiplier, Model, Base, Kt, Class, Acc Class, 

Func Code, Manufacturer, and Meter Capability options. 

After updating the meter information, users can click “Save” to store the Custom AEP Code along with 

its associated settings for future use. 

To use AEP, it must first be enabled in the Preferences popup. 
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Tags (refer to section 15 - Tags for complete setup). 

Create, edit and delete tags. Tag management in a meter shop serves as a tracking and organizational 

tool, helping technicians and managers efficiently categorize, locate, and manage meters, test 

equipment and related assets. 

 

 

 

 

 

 

4.1.5 Help 

 

 

 

 

 

On the Help menu are four items: 

1. Devices 

Under devices, you will find a submenu listing TESCO’s device types.  By clicking 

on one, you will be directed to the product page on TESCO’s website. 

2. Contact Us 

Not sure how to contact TESCO?  Click here to get the details. 

3. User Manual 

Access the TDM User Manual for the most current version. 

4. About 

Selecting this menu item opens a popup with details on TESCO device software 

versions supported by TDM, along with a button to view the license agreement 

accepted during installation. 
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4.2 Side Navigation Bar 

 

 

TDM’s side navigation bar has five main items, “Devices”, “Database”, “NextGen Testing”, “Knopp 

Testing” and “Knopp XA Testing”. “NextGen Testing”, “Knopp Testing” and “Knopp XA Testing” can be 

shown/hidden depending on the supported device types that were selected under 

Edit/Preferences/Supported Devices from the toolbar.  

4.2.1 Devices 

All supported devices that TDM was able to detect or scan on the list of subnets/IP addresses set by the 

user will be found here.  Your desktop might look like this: 
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4.2.2 Database 

The Database has four submenus: Items, Sequences, Test Results and Import. 

1. Items 

End users will manage the Item records. Item record types are “Meters”, “Cts”, 

“Vts”, “Meter Stations”, and “EVSE Chargers”.  

 

 

 

 

 

 

 

 

 

 

    

 

From this screen items can be: 

• Added on the fly. 

• Imported from a CSV file. 

• Edited. 

• Searched by a specific word or a “tag”. 

• Edited, deleted, viewed (test results), or exported.  Right click to edit, 

delete, view results (which brings you to test results for the item that is 

selected) and custom export. Please note a custom export needs to be 

set up under Management/Custom Export on the toolbar before you 

can perform this task. 
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To Add a Meter: From Item drop down select Meters.  Click “ADD NEW”.  A new record will pop up for 

you to input your meter information. 

 

Click “CONTINUE” to save record.  

 

To add a CT:  From Item drop down select Cts.  Click “ADD NEW”.  A new record will pop up for you to 

input your CT information. 

 

 

 

 

 

 

Meter Setup Fields: 

• Identification: Meter/Commercial/Utility Serial # 

• Specifications: Manufacturer, Model, Catalog #, 
Meter Notes 

• *Form Selection (dropdown) → Populates 
Electrical Ratings: Kh, Kt, TA, Class, Voltage, 
Accuracy Class, Multiplier, based on Form Chosen 

• Base: S, A, B, K, R, T, Z 

• Functionality Code (open form) 

• Capabilities (Check boxes):  
   Bidirectional | KYZ Capable | Demand Capable | Vectorial Arithmetic 
 
 

*Selections for Form defaults update dynamically based on the 
chosen Form. 

 

CT Setup Fields.  Enter key details to set up a Ct: 
 

• Identification: Serial #, Manufacturer, Model # 

• Nameplate Ratio Information:  

o Ratio Number 

o Burden Rating (dropdown) 

o Rating Factor 

o Accuracy Class 

o Max Test Burden (dropdown) 
Click Done 
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Click Save CT 

 To add a VT:  From Item drop down select Vts.  Click “ADD NEW”.  A new record will pop up for you to 

input your VT information. 

 

 

 

 

 

 

 

 

 

Click Save VT 

 

To add a Meter Station: From Item drop down select Meter Stations.  Click “ADD NEW”.  A new record 

will pop up for you to input the appropriate information.  

 

Setting Up a Meter Station.  When setting up a meter station, there are four main components, each 

represented by a corresponding screen in the system: 

• Site Information 

• Meter Information 

• CT Information 

• VT Information 

 

Enter: 

• Serial # 

• Manufacturer 

• Model 
 
Add Ratio Information: 

• Nameplate Ratio 

• Burden Rating 

• Accuracy Class 
 
Click Done 
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While not all stations will require data for every category, the system is designed to accommodate a 

complete setup when needed. Simply enter the information relevant to the specific station you are 

configuring.  

 

Site Setup Fields.  Enter key details to define a site: 
 

• Identifiers: Site ID, Location ID, Location Code 
(unique & user-defined, can add on-the-fly) 

• Address: Address 1 & 2, City, State, ZIP, Country, GPS 
Coordinates 

• Additional Details: Description, Notes (if applicable) 

• Settings: Calibration Frequency, Customer, Form 
(dropdown), Service (dropdown), Default Sequence 
(dropdown) 
 

Only relevant fields need to be filled based on your setup. 
           SAVE STAION 

Meter Setup Fields. Enter key meter details: 

• Identification: Meter Serial, Utility Serial, Comm 
Serial, Manufacturer, Model, Catalog # 

• Configuration: Form (dropdown) → Populates 
Service Type & Default Sequence* 

• Electrical Specs: Base, Kh, Kt, TA, Class, Voltage, 
Accuracy Class, Multiplier 

• Functionality: Functionality Code 

• Capabilities (Check boxes): Bidirectional, KYZ 
Capable, Demand Capable, Vectorial Arithmetic 

*Selections for Service Type & Default Sequence update 
dynamically based on the Form chosen.                SAVE STATION 

VT Setup Fields.  Enter VT Details: 

• Form Selection (dropdown) → Populates                
*Service Type & Default Sequence 

• Phases (A, B, C) → Visible based on form selection 
                    For Each Phase (A, B, C):  
                     Serial # | Manufacturer | Model | Nameplate Ratio 
                     Burden Rating | Accuracy Class 

• Click Copy Phase A to All→ Streamlines data entry 
 

*Selections for Service Type, Default Sequence, and Phases 
update dynamically based on the Form chosen. 
 

SAVE STATION 

CT Setup Fields.  Enter CT details: 
 

• Form Selection (dropdown) → Populates                
*Service Type & Default Sequence 

• Phases (A, B, C) → Visible based on form selection 
    For Each Phase (A, B, C):  

                     Serial # | Manufacturer | Model | Nameplate Ratio 
                     Burden Rating | Rating Factor | Accuracy Class |            
                     Max Test Burden 
 

*Selections for Service Type, Default Sequence, and Phases 
update dynamically based on the Form chosen. 
 

 

        SAVE STATION 
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 To add an EVSE Charger: From Item drop down select EVSE Chargers.  Click “ADD NEW”.  A new record 

will pop up for you to input your EVSE Charger information. 

 

Setting Up EVSE Chargers.  When setting up a charger, there are three main components, each 
represented by a corresponding screen in the system: 

• Charger Information 

• Ports Information 

• Site Information 

Charger Info Setup: 

• Identification: Serial Number, Model Number, 
Manufacturer 

• Specifications: Gfci Rating (mA) 

• Description: Open text field 

• Default Sequence (optional). Choose from:  

o Default SEQ FL, LL - AC Acceptance 

o Default SEQ FL, LL - AC Maintenance 

o Default SEQ FL, LL - DC Acceptance 

o Default SEQ FL, LL - DC Maintenance 
  
     SAVE CHARGER 

Port(s) Info Setup: Click Add Port 

• Port Name: Can be user defined, or system default 
will name Port 1, Port 2, etc. 

• Port Type:   

o CCS1_AC 

o CCS1_DC 

o Tesla_AC 

o Tesla_DC 

o CHAdeMO 
  
     SAVE CHARGER 

 
 

Site Info Setup:  

• Customer Name 

• Site Name 

• Address/City/State/Zip/Country 

• GPS: Coordinates 

• Location Code: User defined; can add on the fly 

• Description: Open Form 
 

     SAVE CHARGER 
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2. Sequences:   The Sequence Section allows users to manage test sequences for 

different equipment types. These sequences define structured test procedures to 

ensure accurate and reliable metering results. 

Devices/Equipment Using Sequences: 

• Meter Test Boards – Series Parallel 

• Meter Test Boards – Three Phase 

• Meter Site Analyzer 

• EVSE Tester 

• Turbo Tester 

• KATC-3 

Users can create, edit, and manage sequence records to match testing requirements for various 

metering and EVSE applications. 

                   

 

 

 

 

 

Sequence Builder:  

• Sequence Name – Name of the sequence. 

• Service.  Choose from: 
Universal | 2-Wire 1 Ph | 3-Wire 1 Ph | 3-Wire Delta CG 

3-Wire Network | 4-Wire Wye (2V2I) | 4-Wire (2V3I) 
4-Wire Wye | 4-Wire Delta (3V2I) | 4-Wire Delta 

• Tolerance %. Pass/Fail Requirements. 

• Sequence Notes. Free form entry. 

• INDEX Tag |Description 

o TAG – Name/Type. 

o Description – Brief explanation of what it 
is. 

o “+ “– Adding a new Test. 

o REMOVE – Deleting a Test. 

o EDIT – Editing a Test. 

o UP and DOWN arrows – Changing the 
order of the Test Tag. 
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Meter Test Boards – Series Parallel & Three Phase  

For Meter Test Boards (Series Parallel or Three Phase), when a user selects a service type other than 

Universal, an Advanced Tag option becomes available under the Load Type section. (The Advanced Tag 

option appears as “ADV” in the drop-down menu) Within this option, users can configure Parameter 

Shift Increment, like the functionality available in TMA. 

This feature enables users to adjust key test parameters, including: 

• Voltage  

• Current  

• Phase  

In addition, the interface provides checkboxes that allow users to enable or disable specific channels, 

such as voltage or current, based on the testing requirements. 
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Note: To save the sequence, the user must enable at least one channel in both Series Parallel and Three 

Phase Meter Test Boards. 

 

 

 

 

 

 

 

 

http://www.tescometering.com/


 

 
 

 

Installation Guide 

    tescometering.com                     +1 215 228 0500

                support@tescometering.com 
28 

3. Test Results 

Users can view and export test results for: 

• Meters 

• Meter Stations 

• EVSE Chargers 

• CTs 

• VTs 

  

The right-click context menu in the Test Results table adapts depending on the number of selected rows. 

When a single test result is selected, the menu displays options specific to that result. If the selected row 

has a result that can be opened, the menu includes View Sequence Result, which opens the View Results 

popup for that test result. If no result is available, this option does not appear, even when only one row 

is selected. 

Other actions available for a single selection may include: 

• Delete  

• Create PDF Report  

• Export to CSV  

• Export to DAT  

• Custom Export 
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When multiple test results are selected, the context menu displays options that apply to the entire group. 

Most of the same actions are available, with the addition of Export to CSV (Unified by Device SN). View 

Sequence Result is not shown, since it only applies to a single selected result with a viewable sequence. 

This design allows users to perform either single-result actions or batch actions, depending on the number 

of selected rows and the availability of viewable results. 
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Easily Identify test failures by the red font; double click on the device you would like more information    

on, and a new pop-up screen will open and show all the details for that record.  

From here you have three choices: EXPORT TO PDF, EXPORT TO CSV, EXPORT TO DAT (data file) – will be 

saved automatically in the default path that is set in the system (refer to section 11 for complete export 

instructions). 

 

                         EXPORT TO PDF             EXPORT TO CSV 

 

 

 

 

                             EXPORT TO DAT 

 

 

 

 

1 2 3 

File Exported to: 

C:/users/Meter Shop/Documents/TD-Reports 
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4. Import (Refer to Section 12 for complete import instructions). 

End users can import a CSV file to create item records for: 

• Meters 

• CTs 

• VTs 

• Meter Stations 

• EVSE Chargers 

To ensure accurate data mapping, the system can generate a CSV template to use, or 

you can choose to select a file. Be sure that the template headers in your file match 

those of the CSV Template.  

Use drop-down menu to pick item types to import, Click GENERATE CSV TEMPLATE – a 

pop up will appear identifying headers for import. Click Create Template.  Another 

popup will appear for end-user to choose path for file to be saved. 
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4.2.3 NextGen Testing 

NextGen Testing allows users to control their meter test board(s) remotely.  Meter 

shops can remotely trigger meter diagnostics, verify meter accuracy, check demand and 

KYZ pulse functionality and detect errors or tampering.  Test choices include Bulk Test 

and Manual Test. 

Bulk test allows you to test multiple devices/test boards simultaneously if they are 

connected to the network. The Manual testing is for just one device.  

In the Bulk Test section, the end-user can set/edit meter parameters as well as  

add/remove sockets (devices to be tested). 

                              

 

 

 

 

 

 

 

 

 

 

 

 

View/Edit Meter Parameters 

• Unit Details: Manufacturer, Model, Cat# 

• Form | Base 

• Kh | Kt | TA | Class | Voltage |Acc. Class 

• Functionality Code. Open Form 

• Multiplier. Use up down arrow to select. 

• Meter Function: 
KYZ Capable | Bidirectional  

 Demand Capable  | Vertical Arithmetic 

• Notes. Free form entry 

• Series Parallel. Service/Sequence 

• Three Phase. Service/Sequence 
CONFIRM 
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Meter Lookup Icons  

The icons next to the meter lookup fields help show the status of the entered serial 

number values. If the meter is new, it is not already in the database, and does not 

conflict with another meter record, no icon is shown.   

The revert icon is shown only when the meter already exists in the database and one of 

the fields has been changed from the value stored for that meter. This allows the user to 

restore the original value from the database.   

The crossed-out circle icon means the entered serial number cannot be used because it 

already exists in the database as part of a different meter record.  

The exclamation mark in a circle icon means there is already a meter in the database 

with that same serial number.  
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Bulk Testing. During the bulk testing process, end-users can:  

• Start Test  

• View Status 

• Click Voltage On/Off 

• Click Pulse Align/Stop P.A. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Click “VIEW STATUS” will provide information specific to that meter.  You will 

notice that manual test is highlighted – that is a result of viewing one meters’ 
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information. You are still in Bulk Testing. Click on “Bulk Test” once again and it will bring 

you back to your Bulk Testing Screen. 

 

Manual Testing.  During manual testing select the device you wish to test. 

With a Manual test you will find two different tabs: 

• Sequence: certify meters to precise specifications. 

• Drive/Unit Testing: simulate field conditions. 

 

1. Sequence: This tab is used for manual test step control—essentially walking through a 

test plan one step at a time, typically with the help of a reference standard. 

Use Case in a Meter Shop: 

• When a technician wants to manually validate each element of the meter test 

process (e.g., different loads, power factors, or service types). 

• Ideal for custom tests, troubleshooting, or when fine control is needed over the 

test environment. 

• Each step in the sequence might change things like current/voltage levels or 

timing, and the operator can choose to advance or repeat steps. 

Why It Matters: 

• Gives full control for diagnostic or non-standard tests. 

• Helpful for training new technicians, so they can see the result of each test step. 

• Useful when testing complex meters that might not fit into a default auto test 

plan. 

End-users select a device; attributes associated with that meter are populated 

automatically.  Click “EDIT” if any of the information needs to change because of 

configuration differences, test procedure adjustments, field conditions or 

regulatory/compliance updates. Once sequence is selected click “START SEQUENCE” to 

test. 

 

 

 

 

Customer complaint  
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Protocols have been set in place to notify end-users of any issues that need to be 

addressed.  In this example you will see a flashing message “unit needs input” notifying 

you that attention is required and that there is a possible issue detected.  Click on the “i” 

to find out what the issue is. In this case the system Detected a short on VC, informing 

you that perhaps you will need to verify the wiring, check for damage, and troubleshoot 

as needed. Click “OK” to close the window. 

NOTE: Once the issue is recognized by clicking “OK”, the flashing message will 

disappear.    

 

2. Drive/Unit Testing 

Drive/Unit testing is central to manual control testing in a meter shop and gives 
technicians real-time control over the power applied to the meter.  

Let’s break the screen down into five sections (see image below – section 5 
GRAPHS): 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 
2 

3 

4 

5 
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Section 1: NEXTGEN DEVICE 

Select Device (this list displays all devices/test boards that are connected to 
network).   

Note: 
The Meter Information section is dynamic and will automatically adjust based 
on the type of device or test board selected. For example, selecting a Three 
Phase Test Board, Three Phase Qualification Board, or Series Parallel 
Qualification Board will display different configuration fields specific to the 
capabilities and requirements of that hardware. Ensure that the correct test 
board is selected prior to entering meter data, as this directly affects the 
available input options and test parameters. 

Section 2: METER INFORMATION 

If applicable, Click “EDIT” if you need to change any of the following 
parameters: 

Meter SN (Serial Number): Internal tracking of the specific meter being tested. 

Comm Serial / Utility Serial: Optional fields for communication module serial 
number or a utility-assigned identifier. 

Manufacturer: Dropdown to select the manufacturer (e.g., Landis+Gyr, Itron, 
etc.). 

Model: Specific model number of the meter. 

Catalog #: Internal reference or part number for utility inventory tracking. 

Meter Notes: Free text field for special conditions, known issues, or testing 
context. 

Form: Indicates the meter wiring configuration (e.g., 9S for 3-phase, 4-wire). 

Base: Typically either S (socket-based) or A (bottom-connected). 

Kh: Watt-hour constant; the energy represented by one pulse. 

Kt: Test constant; used by the test system to calculate expected pulses. 

TA: Test Amps; usually matches CT rating or nominal current for test setup. 

Class: Meter class, representing load capacity (e.g., Class 20 = 20 amps). 

Voltage: Nominal service voltage the meter is rated for. 

Acc. Class: Accuracy class, such as 0.5 or 1.0, defines the maximum allowable 
 error under test. 

Multiplier: External multiplier applied when actual load exceeds meter capacity 
(common in CT-rated meters). 

Functionality Code: Optional entry to capture special features or firmware 
revisions. 

□ Check box for: 
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Bidirectional: Indicates the meter can measure both import and export energy 
(used for net metering or solar applications). 

KYZ Capable: The meter has KYZ outputs—dry contact pulse outputs for load 
profiling or SCADA integration. 

Demand Capable: Meter supports demand measurements (e.g., kW demand 
tracking). 

Vectorial Arithmetic: Meter uses vector math (phasors) instead of arithmetic 
summation—important for polyphase power accuracy. 

Click “continue” to save changes. 

    

Section 3:  Drive Section 

   RMS / PHASE / WAVEFORM Settings: 

• VA / VB / VC: Voltage each phase  

• IA / IB / IC: Current   

• Phase Angles: Represents the timing offset of each phase. 

• Waveform: The availability of specific waveform options depends on the 
selected device/test board and the configured service type (e.g., 4-Wire 
Wye, Delta, Series-Parallel, etc.). Not all waveforms are available for every 
configuration. 

 

 

Waveform Description 

SINUSOIDAL Standard clean sine wave; used in most accuracy tests. 

Quad_V.ansi/Quad_I.ansi Quadrature waveforms (90° phase shift) to simulate leading/lagging loads. 

Pulse_V.ansi/Pulse_I.ansi Pulsed waveform to simulate rapidly switching or bursty loads. 

Peaked_V.ansi/Peaked_I.ansi 
Peaked or high crest factor waveform; used for testing non-linear load 
effects. 

MZCV / MZCC (V/I) 
Custom waveforms used for meter qualification or standard compliance 
testing. 

90_deg_V.ansi / 90_deg_I.ansi Extreme 90-degree phase shift to test reactive power scenarios. 

3rd Harmonic Voltage waveform with injected 3rd harmonic distortion. 
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Section 4: TEST PARAMETERS 

The Test Parameters section is dynamically configured based on the selected device or test board. Not 

all test boards support the same range of test types, and available fields may change accordingly. For 

example, a three-phase Qualification Board may only allow one test type and duration while a three-

phase Test Board will have a choice of test type, pulses, warm up, tolerance, iterations and 

measurement type. 

Select: “Test Type”.  (Some) Test Types Available 

Test Type Purpose 

Meter Accuracy 
Verifies meter accuracy against a reference standard by comparing pulses to 
expected values. 

Meter Drive Tests the mechanical drive of the meter (used for electro-mechanical units). 

Meter Time Run 
Measures the time it takes for a specific number of pulses—used in legacy 
methods. 

Meter Timed Register Times the register’s operation over a known load condition. 

Meter Energy Delivery 
Confirms the meter is recording energy flow correctly (especially in bi-
directional meters). 

Meter Demand Evaluates the meter's ability to calculate and report demand over time. 
 

Click: “Start Test” 
 

Section 5: GRAPHS 

The graphs section provides a real-time visual representation of the voltage and 

current waveforms applied to the meter under test.   
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4.2.4 Knopp Testing  

This section allows users to monitor live measurements from the KCTS/KVTS and to retrieve and store 

measurement results from the unit. It provides two measurement views: Main and Engineering 

(described below). In addition, users can configure reference standard information (REF INFO) and 

settings for the TUT. 

Connecting to a Device  

To connect to a device, click the SELECT DEVICE button and choose from the list of available Knopp 

devices.  

IMPORTANT: Ensure that the Knopp Comparators option is enabled under Supported Devices in 

Preferences. Refer to section 5.1 for more details. 

Updating TUT Information  

In TUT INFO section, basic TUT information fields can be set:  

Ct SN  Serial number of CT. 

Nameplate Ratio  Ratio (Primary, Secondary) as indicated in the CT nameplate.  

Rating Factor  CT rating factor. 

Burden Rating  CT ANSI burden rating.  

Acc. Class  CT accuracy class. 

For a more thorough update of CT information, users can also click EDIT button (see Setting of CT 

information section).  

NOTE: TUT information must be set in order to save captured measurement results.  
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MAIN VIEW 

This view displays key measurement values for both the reference standard and the Transformer-Under-

Test (TUT), including RMS and accuracy-related data. Options are available to adjust the measurement 

units (see below). 

 

 

 

 

 

 

 

 

 

 

 

 

 

RMS Unit 

AMPS  Express REFERENCE / TUT RMS in Amperes. 

% FS  Express REFERENCE / TUT RMS in percentage where full scale (FS) is 5 Amps.  

Phase Unit 

DEGREES  Express Phase units in degrees.  

MILLIRADS  Express Phase units in milliradians.  

MINUTES  Express Phase units in minutes.  

RCF or % ERR 

RCF  Express error in Ratio Correction Factor.  

% ERR  Express error in percentage.  
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ACC. CLASS or TCF 

ACC. CLASS  Express TUT accuracy in percentage.  

TCF  Express TUT accuracy in Transformer Correction Factor.  

LIVE MEASUREMENTS 

REFERENCE  Fundamental RMS readings of REFERENCE transformer (secondary).  

TUT  Fundamental RMS readings of TUT transformer (secondary).  

 

ENGINEERING VIEW 

In contrast to Main view, this option shows a lot more information which can be useful for engineering 

assessment. Furthermore, values can be expressed as raw or standard deviation as indicated by the Data 

Type option.   

 

 

 

 

 

 

 

 

CHANNEL DATA 

RMS  RMS readings of either REFERENCE, ERROR or TUT channels.  

PHASE  PHASE readings of either REFERENCE, ERROR or TUT channels.  

NOTE: All phases are referenced from the REFERENCE channel.  

THD  Total Harmonic Distortion values for REFERENCE, ERROR and TUT channels.  

ACCURACY DATA 

RCF  Ratio Correction Factor of the TUT.  

Phase Error  Phase Error of the TUT.  

TCF  Transformer Correction Factor of the TUT.  
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Measured vs Computed Values  

Measured values are measurements coming directly from metrology of the unit. Computed values 

are derived values using the error channel measurement of the unit.  

  

Saving Results  

Results are displayed on a table in the SEQUENCE RESULTS section once they become available. This 

requires the operator to perform a HOLD DATA and RELEASE in the KCTS unit.    

To save results into TDM, click “Save” button. NOTE: KCTS/KVTS does not have an internal database, so 

it is a good idea to save the results in TDM.  
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4.2.5 Knopp XA (KATC-3) Testing  

This section allows users to remotely perform testing on the Knopp XA unit. It also enables configuration 

of test parameters, including the test ratio and selection of active TUTs. Live measurement results can 

be viewed in either Basic or Engineering modes. 

 

How to Connect to Device  

To connect to a device, click on “SELECT DEVICE” button and select from a list of available Knopp 

devices.   

IMPORTANT: Make sure Knopp Comparators option is enabled in the Supported Devices in Preferences. 

See section 5.1 for more information.   

Setting TUT Parameters  

TUT parameters are configurations related to the TUTs to be used for testing. First, set the ratio (Primary 

and Secondary) of the TUTs to be tested. Next, in the ACTIVE TUTs section, check all necessary TUT 

numbers that will be used for testing then fill out their basic information:  

Serial  TUT serial number.  

Tap #  (Read-only) Indicator of TUT tap number that matches Test Ratio.  

Max. Burden  TUT max. ANSI burden.  

Acc. Class  TUT Accuracy Class rating.  

RF  TUT Rating Factor.  

  

NOTE: When selecting TUT 5, all the other TUTs are disabled.   

Click “EDIT…” button for a more complete way of setting the TUT information   

For ease of use, each Serial field has an auto-matching feature that can list down all matching serials 

from the database.  
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MANUAL VIEW 

This option allows users to run a single test. The MANUAL PARAMETERS section provides the following 

test parameters:  

 

 

 

 

  

  

 

 

 

 

Test Type  The test to perform (Ratio with Burden, Demagnetization).  

Test Burden  ANSI Burden to use for testing.  

Load Type  Secondary test current:  

FL – Full Load test current (5 Amps)  

LL – Light Load test current (0.5 Amps)  

RF – Derive test current from Rating Factor of each active TUT (5*RF)  

Amps – Custom test current in Amps  

%FS – Custom test current in percent full scale  

  

Sec. Test 

Current  

NOTE: Available only for AMPS and %FS Load Types  

The actual test current.   

User Notes  Test Notes that get saved with the results. This is not required.  

  

After setting the test parameters, START TEST button can be clicked to start the test.  

  

NOTE: At least one active TUT should be selected for the test to start.   

When test is running, the START TEST button becomes the STOP TEST button that can be clicked to stop 

the test.  
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SEQUENCE VIEW 

This option allows users to run a sequence (series of tests). The SEQUENCE PARAMETERS section 

provides the following test parameters:  

 

 

Sequence  Name of selected sequence to run.   

NEW button  Creates a new sequence to run.   

EDIT button  Edits the currently selected sequence.   

Test Reason  The reason for running the sequence. This is not required.  

User Notes   Test Notes that get saved with the results. This is not required.  

SKIP TEST button  Available only when test is running. Click to skip current test in the sequence.  

Active Test  Available only when test is running. Shows the progress of the running sequence.  

  

Viewing Results  

The Knopp XA testing page provides these sections to view live measurements and results of the running 

test.  
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LIVE MEASUREMENTS Section 

This section displays live measurements data in either BASIC or ENGINEERING view. BASIC view displays 

the following:  

   

LIVE MEASUREMENTS - BASIC 

ACC. CLASS  TUT Accuracy class.  

Phase Error  TUT Phase error.   

RCF  TUT Ratio Correction Factor.  

REFERENCE  Fundamental RMS readings of REFERENCE transformer (secondary).  

TUT  Fundamental RMS readings of TUT transformer (secondary).  

ENGINEERING VIEW 

button  

Click to show ENGINEERING values.  

LIVE MEASUREMENTS - ENGINEERING 

Data Type  Option to either show RAW or Standard Deviation (STDEV) values.  

RMS  RMS readings of either REF, ERROR, TUT, VOLTAGE or Z channels.  

PHASE  PHASE readings of either REF, ERROR, TUT, VOLTAGE or Z channels.  

NOTE: All phases are referenced from the REF channel.  

RCF  TUT Ratio Correction Factor.  

Phase Error  TUT Phase Error.  

TCF  TUT Transformer Correction Factor.  

THD  Total Harmonic Distortions for either REF, ERROR or TUT channels.  

BASIC VIEW button  Click to show BASIC values.  

  

Measured vs Computed Values  

Measured values are measurements coming directly from metrology of the unit. Computed values 

are derived values using the error channel measurement. After setting the test 

parameters, START SEQUENCE button can be clicked to run the sequence.   
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NOTE: At least one active TUT should be selected before running sequence.   

When sequence is running, START SEQUENCE button becomes CANCEL SEQUENCE button that can be 

clicked to abort sequence.  

SEQUENCE RESULTS section  

Partial and final results for each test in the sequence are listed in this section.   

TUT                The TUT no. for the test.  

INDEX-ITER         The Index and Iteration of the test.  

TAG                The test TAG.  

TEST BURDEN       The target test burden of the test (blank for Demagnetization test).  

TEST CURRENT      The target test secondary current of the test (blank for Demagnetization 

test).  

PRI. CURR.         The measured primary current of the test (blank for Demagnetization 

test).  

SEC. CURR.         The measured secondary current of the test (blank for Demagnetization 

test).  

RCF                The computed RCF of the test (blank for Demagnetization test).  

Δ PHASE            The computed delta phase of the test (blank for Demagnetization test).  

COMP. ACC. CLASS  The computed accuracy class of the test (blank for Demagnetization).  

STATUS   The live status of the test. Possible values:  

(PASSED, FAILED, ONGOING, PENDING, SKIPPED, ERRORED).  
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5 SETTING UP PREFERENCES IN TDM 

The Preferences section of TDM allows users to tailor the software environment to meet their specific 
needs and workflow requirements. From selecting the devices you’ll be working with—such as test 
boards, site analyzers, or EVSE testers—to customize the visual elements of charts, diagrams, and 
graphs, this area provides flexibility to align TDM with your operational standards. 

Here, users can define critical settings such as backup locations for the TDM database, default 
directories for saving reports, and even the structure and nomenclature of reporting fields. 
Customization options also extend to reporting capabilities, ensuring that the data output from TDM 
matches the format and style preferred by your organization. 

By configuring these preferences, users can enhance efficiency, maintain consistency, and create a more 
intuitive and user-friendly experience within the TDM platform. 

 

5.1 Setting Supported Devices 

 

On the General Tab you choose two settings: supported devices and color scheme for reporting 

purposes. 

The first setting allows users to select the supported device types they plan to use within TDM, such as 
Meter Test Boards, Meter Site Analyzers, or Knopp Comparators. Enabling a device type prompts the 
system to recognize and communicate with that equipment, unlocking all the relevant features for 
testing and data collection. Disabling a device type will hide and deactivate any associated tools or 
functions to streamline the interface. 
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5.2 Setting Colors for Charts/Diagrams/Graphs 

 

The second setting customizes the colors used in charts and diagrams, including Phasor diagrams and 

waveform setup previews. This allows you to create visually distinct and easy-to-read representations of 

your data, helping you quickly analyze patterns and insights. 

5.3 Backing up TDM’s Database 

 

0 
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This option allows users to create a secure backup copy of TDM’s database, helping to preserve data 

integrity and prevent data loss in the event of system failure or unexpected issues. 

 

 

5.4 Creating and Syncing with a database on a Network folder 

 

Network Shared Database File Location allows users to specify the path to a shared folder on a network 

drive, enabling TDM to access and store its database in a centralized location. If a database does not 

already exist at the specified path, TDM will automatically create one. 

This feature is designed to support collaboration by allowing multiple TDM users to connect to the same 

network database. When all instances of TDM are pointed to this shared location, users can maintain a 

consistent and up-to-date dataset across systems. 

To enable this functionality, the selected path must be located on a shared network drive accessible to 

all intended users. Once configured, the option to Sync with Network Drive Database becomes 

available under the File menu on the toolbar. This allows users to share their local data by pushing it to 

the shared network database—ideal for updating the centralized repository with new data pulled from 

field devices. 

NOTE: Use the Sync Network Shared Database option in the General dropdown to ensure your local 

TDM instance stays in sync with the shared network database. 
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5.5 Changing the number of rows shown at a time on the tables in 

TDM 

 

 

 

 

 

 

 

 

 

This setting allows users to define the number of rows displayed in TDM tables, primarily affecting tables 

on the Database page and sync popup tables. 

5.6  Showing results from deleted Items 

 

This setting allows users to include or exclude test results associated with deleted items—such as 

Meters, Meter Stations, or EVSE Chargers—from the database results table. When set to Yes, results 

from previously deleted items (including Meter Sequence Results, Meter Station Sequence Results, and 

EVSE Sequence Results) will continue to appear in the results display. When set to No, these results will 

be hidden from view. 
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5.7 Setting Report preferences 

 

The Report tab allows users to tailor the appearance and content of test reports generated by TDM. 

These settings control formatting, data references, export preferences, and branding. Please note 

changes made in this tab will only apply to reports generated after the changes are saved.   

 

5.7.1 % Error vs Registration 

 

 

 

 

 

 

 

 

 

This setting determines how measurement results are displayed in the final calibration report. Users can 
choose between two display formats: 
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• Use % Error. This is the default and most commonly used format. It displays the measurement 
result as a percentage error, calculated using the difference between the reference value and 
the DUT (Device Under Test) value. This format is recommended for most testing scenarios and 
aligns with standard accuracy reporting methods used in compliance testing. 

• Use Registration. This option displays the DUT's actual registered value (such as pulse count or 
energy reading) instead of calculating a percentage error. It is typically used when comparing 
energy registration or pulse-based devices and may be required in specific testing protocols. 

 

Recommendation: Unless your calibration process specifically requires registration values, it is 
recommended to use % Error for consistency, traceability, and reporting clarity. 
 

5.7.2 Use Latest Revisions 

 

 

 

 

 

 

 

 

 

By default, TDM will use the Revised data during test. However, users may discover that they must make 

some corrections on the item records, i.e. Meter’s manufacturer is incorrect. By selecting “Use Latest” 

after making the changes, TDM will use the updated information in exporting the reports. 

 

5.7.3 Export Path 

 

 

 

 

The Export Path field specifies the folder location where all calibration reports will be saved. Users can 

modify this path by clicking the “Browse” button and selecting a preferred directory. 
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5.7.4 Meter Test Report 

 

 

 

 

 

 

 

 

 

By default, TDM generates calibration reports using its own standardized format. If preferred, users 

can select the “Use TMA Report Format” option to generate reports in the legacy style used by 

TESCO's previous software, TMA. This option may be helpful for end users who are familiar with 

that format or who require consistency with historical documentation. 

Note: The TMA format is optional and primarily provided for backward compatibility. 
 

5.7.5 Custom Logo for Reports 

 

 

 

 

 

 

 

 

 
TDM allows users to personalize their calibration reports by adding a company logo. To upload a 
logo, click “Browse for Custom Logo” and select an image file in one of the supported formats: .jpg, 
.jpeg, .bmp, or .png. The selected image will be scaled to a height of 100 pixels for optimal 
placement on the report. 
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Note: You can remove or update the logo at any time using the “Remove Custom Logo” or 
“Browse for Custom Logo” options. 

5.8 Changing the placement order of Meter Serial fields 

Minimal View (default)  

This is the standard meter information view from previous versions of TDM. It shows limited meter 

information fields and meter information look up is always based on the Meter Serial 

Number (see Meter Lookup Process section).  

 

 

Preview (Minimal view)  

 

 

Complete view   

In Complete View, all the meter information fields become available. In contrast to Minimal View where 

only the Meter Serial Number is the basis to look up meter information, this view allows for customizing 

the meter search basis which can either be Meter Serial Number, Utility Serial Number or Comm. Serial 

Number. The selected search basis field is indicated by the  icon.   
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Preview (complete view)  

 

By default, the meter serial fields are arranged in the following order: Meter Serial Number, Comm 

Serial, and then Utility Serial. Users may modify this sequence as needed to align with their 

organizational preferences or reporting standards.   
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5.9 Setting the default DAT file export location 

  

When TDM exports DAT files, it refers to a predefined export path. The following preset locations are 

currently available: 

1. P:/bham 

2. P:/eastern 

3. P:/mobile 

4. P:/southeast 

5. P:/southern 

6. P:/Western 

Alternatively, users may define a custom export path by clicking “Browse” and selecting a preferred 

directory. 

Note: Ensure the selected path is accessible to all users who will need to retrieve or upload DAT files. 
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5.10 Changing the displayed text for certain labels 

 

TDM allows users to customize the displayed text for specific labels to better match internal naming 

conventions.  The following labels can be renamed: 

1. Meter SN 

2. Utility Serial 

3. Comm Serial 

4. Site ID 

5. Loc. ID 

6. Loc. Code 

Note: Updating label text affects only how the fields are displayed within the application and reports. It 

does not alter the underlying database fields or stored data. 
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5.11 Autofill based on AEP Codes 

The AEP Code feature automatically loads meter information based on the selected AEP code. When 

AEP Codes are enabled in Preferences, users can enter or select an AEP code on supported screens, such 

as the New/Edit Meter popup and the NextGen Manual page. 

When an AEP code is entered, the application retrieves the meter information associated with that code 

and populates the relevant fields. This may include details such as Form, Kh, TA, Voltage, and other 

supported meter settings, allowing users to complete meter information more quickly and consistently. 

The Custom AEP Code feature functions similarly but uses user-defined configurations instead of only 

the standard default AEP data. A Custom AEP Code can store its own complete set of meter information. 

When a saved Custom AEP Code is entered, the application loads the associated values into the page. 

If a Custom AEP Code is configured to override the default AEP code, its custom meter information will 

be applied instead of the standard default values. This provides flexibility, allowing users to maintain 

standard AEP behavior while also supporting company-specific or test-specific meter configurations. 

In summary, the AEP feature loads meter data based on the selected code, while the Custom AEP 

feature loads data from a user-defined version of that code when available. 

This feature is only available when the meter search basis is set to Meter SN or Utility SN. 

 

 

 

 

 

 

 

 

 

 

 

FIELD OPTIONS 

AEP CODE: This option enables AEP Codes within the application. When selected, the system will use 

AEP Codes wherever they are supported, including the New/Edit Meter popup and the NextGen Manual 

page. For more details on how AEP works, refer to the Default Settings popup. 
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 LOCATION CODE: This option adds a Location Code field to the NextGen Manual page. It is used to 

specify the location of the device under test. 

NextGen Manual Page Preview 

   

 

 

 

 

 

 

 

 Location Code Popup: Enabling this option in Preferences will warn the user with a popup if the 

Location Code does not match before the sequence starts. 
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The Location Code icon indicates whether the entered Location Code matches the connected device. 

On the NextGen Manual page, the Location Code field allows users to set the Location Code for the 

device for the current test sequence. 

When a Location Code is entered, the application compares it to the value reported by the connected 

device. The icon provides a quick visual cue when the values do not match. 

If there is a mismatch, a warning icon appears next to the field. Hovering over the icon displays a tooltip 

with additional details, including: 

• A message indicating that the Location Code does not match the connected device  

• The Entered Location Code  

• The device’s reported Location Code  

This feature helps users quickly identify when the Location Code entered on the page differs from the 

one detected from the connected device. 
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5.12 TDM Scanner Setup (Prefix + Enter)  

Purpose 

Configure the barcode scanner to send a prefix so TDM can recognize scanner input and place the 

scanned value into the appropriate search field on the Manual Testing page, based on the user’s Meter 

Info search basis preference. 

Required Scanner Behavior 

• Prefix: <T>  

• Suffix / Terminator: Enter (Carriage Return)  

• Each scan should follow this format: <T>052000044577<ENTER>  

How to Program the Scanner Prefix 

The scanner must be configured to send the prefix characters <, T, and > before the barcode value. For 

the scanner model currently used by Tesco, scan the Add Prefix QR code to begin prefix programming. 

For other scanner brands or models, this specific QR code may not work. In those cases, refer to the 

scanner manufacturer’s programming manual and scan the required setup barcodes for the ASCII prefix 

characters in the following order: < T > 

After programming the prefix, save or exit configuration if required by the scanner. 

 

 

        Add Prefix QR code  

 (scanner-specific ex. Tera)  

 

 

                                                ASCII prefix barcodes for other scanners: <   T   > 
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How to Program the Suffix (Enter) 

The scanner must be configured to send an Enter key at the end of each scan. This can be set as: 

• Enter  

• Carriage Return (CR)  

• CR/LF (if Enter alone is not supported)  

TDM expects each scan to end with an Enter input so it can recognize that the scan is complete. 

How TDM Determines Where to Place the Scanned Value 

In TDM Preferences, the selected Meter Info search basis controls which field receives the scanned 

value: 

• Meter SN - the value is entered into the Meter SN field  

• Comm Serial - the value is entered into the Comm Serial field  

• Utility Serial - the value is entered into the Utility Serial field  

Users can control where scanned data is placed by selecting the desired search basis in Preferences. 
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6 SETTING TESCO DEVICES UP WITH TDM 

6.1 Setting up a device’s network connection 

TESCO Device Manager (TDM) communicates with TESCO devices over a network connection. Depending 

on your organization's IT environment and security requirements, there are two supported methods for 

establishing this connection:  

1. Through a Router, Switch, or Ethernet Wall Jack 

Connect the TESCO device to your network using a standard Ethernet cable. This allows the 

device to operate within your organization’s network infrastructure, making it accessible to TDM 

from any authorized workstation on the same network. 

 

2. Peer-to-Peer (Ad-Hoc) Connection 

For standalone setups or restricted network environments, you can connect the TESCO device 

directly to a laptop or PC using an Ethernet cable. This creates a direct point-to-point connection 

without requiring additional networking equipment. 

Note: Configuration steps for each method, including IP address setup and scanning options, are 

detailed below. 

6.1.1 Through a router/switch/ethernet wall jack 

To connect a TESCO device to TDM over your organization’s network: 

1. Use an Ethernet cable to connect the TESCO device (such as a meter test board, 

meter site analyzer, or EVSE tester) to an available router, network switch, or 

Ethernet wall jack. 

2. On the TESCO device, navigate to its Network Settings to locate the current IP 

address: 

a. For Meter Test Boards:  

Navigate to SETTINGS → PREFS → GENERAL → NETWORK 

Some models may display two IP addresses; if so, note the primary address.  
 

 
 

b. For Meter Site Analyzers and EVSE Testers:  

Navigate to PREFS → GENERAL → NETWORK. 
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Optional: You may choose to assign a static IP address to the TESCO device. To do so, 

check the “STATIC” option and enter the desired IP address manually. 

 

    Important: If using a static IP, consult with your IT team to ensure the address 

does not conflict with other devices on the network.  

 

6.1.2 Peer-to-Peer/Ad-Hoc 

A peer-to-peer (or “ad-hoc”) connection allows you to connect a TESCO device directly to a PC or laptop 

using an Ethernet cable, without requiring a router or switch. This method is ideal for standalone setups 

or when working outside of a corporate network. 

Step-By-Step Instructions: 

1. Connect the Devices 

Using an Ethernet cable, connect the TESCO device (e.g., Meter Test Board, Meter 

Site Analyzer, or EVSE Tester) directly to a Windows laptop or PC. 

2. Check the Computer’s Auto-IP Address 
On your PC: 

a. Press Windows + R to open the Run dialog. 

                                                                           

b. Type cmd and press Enter to launch the Command Prompt. 

                                                                 

c. In the Command Prompt, type ipconfig and press Enter. 
d. Locate the Autoconfiguration IPv4 Address (typically starts with 

169.254.x.x). 
 Example: 169.254.140.241 — this is your PC’s address on the ad-hoc 
network. 
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3. Configure the TESCO Device’s Network Settings 

On the TESCO device, you will assign a compatible static IP address that is in the 

same range but not identical to the PC’s. 

• If your PC address is 169.254.140.241, set the TESCO device to 169.254.140.242. 

    Do not use the same IP address as your PC. Acceptable range: 169.254.140.0 – 

169.254.140.255 (excluding the PC’s IP). 

Accessing Network Settings on TESCO Devices: 

• For Meter Test Boards:  

Navigate to SETTINGS → PREFS → GENERAL → NETWORK. 

 

 

 

 

• For Meter Site Analyzers and EVSE Testers: Navigate to 

PREFS → GENERAL → NETWORK. 

 

 

 

• Set the mode to “STATIC”. 

• Enter the selected IP address. 

• Click “APPLY”, then “CLOSE”. 
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4. Optional: Confirm the Connection 

Back on your PC, you can confirm the devices are communicating: 

• Open the Command Prompt. 

• Type “ping” followed by the IP address you assigned to the TESCO device (e.g., “ping 

169.254.140.242”) and press Enter. 

• If the setup is correct, you should receive a reply, indicating that the connection is 

active. 

 

 

 

 

 

 

 

 

 

 

6.2 Adding a subnet to the scan list and performing a 

network scan 

1. In TDM, click “Devices” from the side menu, then select “Scan for Devices” to 

open the device scan window. 
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2. In the Scan for Devices popup window, select “Subnet” from the scan type 

dropdown menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Click “ADD SUBNET” button. 

 

 

 

 

 

 

 

 

4. In the Add Subnet popup, enter the first three groups of numbers from the 

TESCO device’s IP address (left to right). For example, if the TESCO device has an 

IP address of “10.20.11.242”, you will need to enter “10.20.11”. 

 

 

 

 

 

 

5. Click “Add” to save the subnet to the list. 
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6. Click “SCAN SUBNETS” to begin scanning the specified network range. 

 

 

 

 

 

 

 

 

 

 

7. Any detected TESCO devices will be listed on the Devices page. 

 

 

 

 

 

 

 

 

 

 

 

Tip: Scanning by subnet is ideal for finding multiple devices on a shared network without needing to 

know individual IP addresses. 
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6.3 Adding an IP address to the scan list and performing a 

network scan 

This option allows you to scan for a specific TESCO device when you know its exact IP address. It’s useful 

when working with static IP assignments or when scanning a broad subnet is not necessary. 

Step-by-Step Instructions: 

1. In TDM, click “Devices” from the side menu, then select “Scan for Devices” to open the scan 

window. 

 

 

 

 

2. In the Scan for Devices popup, choose “IP” from the scan type dropdown menu. 
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3. Click the “Add IP” button. 

 

 

 

 

 

 

 

 

 

4. In the Add IP Address to Scan popup, enter the full IP address of the TESCO device. 

 

 

 

 

5. Click “Add” to close the popup and save the IP address to the scan list. 

 

 

 

 

6. Click “Scan IPs” to begin scanning the specified address. 
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Scanning by IP is ideal when you're connecting to a single known device — especially when you already 

know the exact IP address. 

 

7. Help Icon on Device Cards  

A tooltip is also shown when the user hovers over an icon. The tooltip provides more 

information about what the icon means and what the user should understand from that status.  
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6.4 Removing/Forgetting a device 

If a device is no longer in use or needs to be removed from the TDM device list, you can manually delete 

it using the Forget Unit option. 

 

 

 

Step-by-Step Instructions: 

1. Navigate to the Devices page in TDM. 

2. Locate the device you wish to remove. 

3. Click the “FORGET UNIT” button on that device’s cell. 

Once selected, the device will be removed from the visible list and will no longer appear in future scans 

unless re-added. 

Note: This action only removes the device from the current view in TDM. It does not affect the device 

itself or its network settings. 
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6.5 Performing Software update on a device 

    WARNING: Ensure the device's network connection is stable before starting a software 
update. Interruptions during the update process may result in incomplete installation or device 
communication issues. 

TDM allows users to update the software on supported TESCO devices when a newer version is 
available. This option is only visible if the device is running outdated software. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step-by-Step Instructions:  

1. On the Devices page, locate the TESCO device you wish to update. 

2. If the device is eligible for an update, an “UPDATE SOFTWARE” button will appear on its device 

cell. 

3. Click “UPDATE SOFTWARE” to begin the update process. 

During the update, the device’s screen may go blank (white or black) and restart automatically. This is 

normal behavior. 

4. A progress bar will appear on the device cell in TDM, showing the update status in real time. 
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5. Once the update is complete, the device will automatically reboot and return to its normal 

operating state. 

Note: Do not disconnect power or network cables while the update is in progress. 

 

7 PULLING RECORDS FROM A DEVICE TO TDM (Quick Sync) 

Clicking the “Quick Sync Database” button on the device cell initiates a one-way transfer of data from 

the connected device to your local TDM installation. This process updates the local database stored on 

your computer with the latest records from the device. 

 

 

 

 

 

 

 

 

 

 

Step-by-Step Instructions: 

1. On the Devices page, locate the device from which you want to pull records. 

2. Click the “QUICK SYNC DATABASE” button on the device cell. 

A progress bar will appear, indicating the status of the synchronization process. Once complete, the 

retrieved records will be available in the local TDM database for review or export. 

Note: This action does not remove or alter records on the device itself. It simply ensures that your 

local copy of the database reflects the most current data available. 
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8 MANAGING RECORDS ON A DEVICE (Full Sync)   

 

 

 

 

 

 

 

 

 

To manage meter and sequence records stored on a TESCO device, click the “Full Sync Database” 

button located on the device cell.  

This will open the Full Sync window for the selected device. 

Unlike Quick Sync, which only pulls data from the device into TDM, Full Sync is bidirectional meaning 

it updates and synchronizes records between the device and your local TDM database. 

Once the Full Sync window is open, you can review and select which items should be retained or 

removed on the device. The interface is organized into two tabs: 

• Meters – Displays all meter records available for syncing. Please refer to section 8.1 for more 

information/instructions. 

• Sequences – Displays all test sequences available for syncing.  Please refer to section 8.2 for 

more information/instructions. 

After selecting the desired records, click “Next” to proceed through the tabs, then select “Begin 

Upload” to finalize the sync. 
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8.1 Selecting which items to keep on the device 

The items displayed in this section will vary depending on the connected device type. Items that are 

checked indicate records currently stored on the device, while unchecked items are not present on the 

device but still exist in TDM. 

 

 

 

 

 

 

 

• To add an item to the device, check the box next to it. 

• To remove an item from the device, uncheck the box. 

Note: Unchecked items are removed from the device but remain stored in TDM and can be re-added at 

any time. 

• Once your selections are made, click “NEXT” to continue to the Sequences tab. 

 

8.2 Selecting which sequences to keep on the device 

The sequences displayed in this tab will vary depending on the connected device type. Checked 

sequences are currently stored on the device, while unchecked sequences are not present on the device 

but remain available in TDM. 

 

 

 

 

 

 

 

 

• To add a sequence to the device, check the box next to it. 
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• To remove a sequence from the device, uncheck the box. 

Note: Unchecked sequences are removed from the device but remain stored in TDM and can be re-

synced at any time. 

Once your selections are finalized, click “BEGIN UPLOAD” to apply the changes and complete the sync. 

 

9  MANAGING ITEMS IN TDM 

TDM allows users to create, edit, and delete items within the local database. Once changes are made, 

they can be synced to a connected device, making the updated items immediately available for use—

without the need to manually re-enter details on the device.  

To begin managing items in TDM: 

1. From the TDM side menu, click “Database” to expand the submenu. 

2. Select “Items” to access the item management screen. 

From this view, you can perform the tasks outlined in Sections 9.1 through 9.4. 

 

NOTE:  Please refer to section 4.2.2 for a full overview of all the steps associated setting up: 

Meters, CTs, VTs, Meter Stations and EVSE Chargers. 

 

9.1 Creating Items 

To create a new item in TDM, follow these steps: 

1. Select the type of item you wish to create (e.g., Meter, Meter Station, or EVSE Charger). 

2. Click the “Add New” button. 

 

 

 

 

 

In the item editing popup, fill in the required details for the selected item type.  

o Note: The fields presented in the editing window will vary depending on the selected 

item type. For example, the information required for Meters, CTs, VTs, Meter Stations, 

and EVSE Chargers is specific to each category. 

See section 15 for Tags 
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                     Meter                                                             CTs                                                      VTs                     

                           Meter Stations                                                                                 EVSE Chargers                                 

2. Click “Continue” or “Save” to confirm. A confirmation popup will appear once the item has been 

successfully saved to the database. 

Important Note: 

• Each item must have a unique ID. Duplicate IDs are not allowed. 

o Meter: Identified by Meter SN 

o Meter Station: Identified by Site ID 

o EVSE Charger: Identified by Charger Serial 

 

9.2 Editing Items 

To edit an existing item: 

• Either double-click the item, or 

• Right-click the item and select “Edit” from the context menu. 

This will open the editing popup, where you can modify item details and save your changes. 
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9.3 Deleting Items 

To delete an Item. 

• Right-click the item and select “Delete” from the context menu. 

    Note: Deleted items cannot be recovered. Ensure accuracy before confirming deletion. 

 

 

 

 

 

 

 

9.4 View Results 

To make sure that TDM has all the latest records from a device, do a Quick Sync (refer to Section 7 for 

details/instructions) first on the Devices page with the test device. 

To view a test result for a specific item: 

1. Navigate to Database -> Items page. 
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2.  

 

 

WITH RESULTS OPTION 

 

This option enables users to see Items with Results only.  
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3. Select the item’s record type (Meter/Meter Station/EVSE Charger) on the dropdown at the 

upper left corner of the page. In this example, we are going to view a Meter’s test result. 

 

 
 

 

 

4. Look for the item associated with the results that you want to view. You may filter the item by 

entering a text on the search bar or by applying tags. 
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5. Right click on the item then click “View Results” on the context menu. 

 

 
 

 

 

 

 

 

6. TDM will switch the page to Test Results and display the test results of that item. 
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7. Right click on a result you wish to view then click “View Sequence Result” on the context menu 

to open the View Test Result popup. This can also be done by double clicking on a result on the 

table. 

 
 

 

8. Test Result details will be shown on the View Test result popup 
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9.5 Custom Export 

To run a custom export on the selected items, right click on one of the selected/highlighted items and 

then click “Custom Export” on the context menu. 

 

 

 

 

NOTE: Custom export scripts are categorized on which item/result type the script would be run. An error 

would be shown if a custom export script is run against an unsupported category. 

IMPORTANT NOTE:  If no custom export script has been created for the selected table, TDM will display 

the message: “No Custom Export created for table yet! Please add one first by going to Management > 

Custom Reports.” 

 

 

 

To resolve this, navigate to Management > Custom Reports and create or assign an export script for the 

relevant item or result type. 

 

9.6 NISC Export Features  

To export NISC Meter Test Data Format:  

Navigate to TDM. In TDM, go to Database Items, then select Meters from the Items list.  

  

After selecting one or more-meter records, right-click and choose Export Results (NISC).  
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Next, go to Settings and specify the Export Path and Set the file format.  

Note:  

Export Path: This is directory where the CSV file will be exported to.   

File Format: This is the filename format of the CSV file. Filename parameters 

(<DateTimeStamp>, <GUID>) can be used to automatically insert system-generated values.

   

<DateTimeStamp> - Inserts a date/time stamp value  

<GUID>- inserts a Globally Unique Identifier (GUID) value.   

See, RFC-4122 (https://www.rfc-editor.org/rfc/rfc4122) for more information on this 

standard format)  

  

  

 

From the above image (SFTP):  

• URL: This refers to the IP address or URL of the SFTP server.  

• Username: This is the username used to log in to the SFTP server.  
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• Password: This is the password associated with the SFTP account.  

  

There are two options for exporting NISC meter test records: -  

Option 1 is to export the file to the Export Path only. In this case, SFTP should be turned off, and the 

system will generate the CSV file solely in the local folder.  

 
 

The above image shows that SFTP is disabled. the file will be generated only in the specified 

Export Path 

 
The popup in the above image indicates that the CSV file has been generated and the export 

file has been created. Clicking Open File will navigate to the file location 

  

Option 2 allows exporting the file to both the Export Path and an SFTP location. To use 

this option, SFTP must be enabled, and the destination Client Server Software details (URL, 

Username, Password) should be provided in Settings. Once these details are saved, 

exporting the records will generate the CSV file in both locations, ensuring the data is 

available locally as well as on the remote server.  
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The above popup shows that the CSV file has been generated and successfully pushed to the 

SFTP server, and the export file has been created. Clicking Open File will take you to the file 

location 
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When using Option 2, if you do not want a local copy of the CSV, you can 

uncheck Create copy of CSV on Export Path, as shown in the image below.  

  

  

The above image shows the CSV file was generated and successfully pushed to the SFTP server 
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To verify the exports: We can use WinSCP or any SFTP client software and log in with the 

same credentials that were used to configure the SFTP. This allows you to confirm that the 

CSV file has been successfully uploaded to the remote location.  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                        

The image shows that the file has been successfully exported to the remote location using 

WinSCP 
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10. EXPORTING RESULTS 

TDM supports exporting test results from connected TESCO devices in a variety of formats, including 

CSV, PDF, and Custom Export formats. These exports can be used for reporting, archiving, or integrating 

with other systems. 

10.1 Exporting to CSV 

TDM allows users to export test results in a CSV format that is designed for readability and ease of 

use. Unlike a standard flat-file CSV with a single header row, TDM’s CSV format mirrors the layout of 

the View Test Result popup for consistency. 

There are few ways to perform a CSV export: 

• From the View Test Result popup, click the “Export to CSV” button. 

• From the Test Results page, right-click one or more test results and select “Export to CSV” from 

the context menu. 

        

• From the Test Results page, right-click one or more test results and select “Export to CSV” from 

the context menu.  

• The files will be saved to the directory specified in the Export Path under the Report tab in the 

Preferences popup. To access this setting, go to Edit > Preferences. 
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• When exporting multiple test results using Export to CSV (Unified by Device SN), the selected 

results are combined into a single CSV file. For CT and VT results, the export is formatted so that 

each individual result appears in a single row, making the data easier to review, sort, and 

compare. 
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10.2 Exporting to PDF 

PDF exports can also be generated in two ways: 

• From the View Test Result popup by clicking the “Export to PDF” button. 

• From the Test Results page by right-clicking one or more test results and selecting “Create PDF 

Report”. 

 

       

If only one test result is selected, the PDF Report Builder will appear, allowing you to: 

• Choose which test results from the session to include. 

• Specify the file name. 

• Select the save location for the PDF report. 

To customize the appearance and layout of PDF reports, go to the Report tab in the Preferences 

popup (found under Edit > Preferences). 

When exporting multiple test results, the files will be saved to the path defined in the Export Path 

setting in Preferences. 

 

 

 

 

 

 

 

http://www.tescometering.com/


 

 

 

     95 

Installation Guide 

     tescometering.com         +1 215 228 0500 

               support@tescometering.com 

10.3 Custom Export 

TDM also supports Custom Export scripts, which can be used to format data according to specific 

internal or third-party requirements. 

To perform a custom export: 

1. Select or highlight the test results to be exported. 

 

 

 

 

 

 

 

 

2. Right-click and choose “Custom Export” from the context menu. This opens the Custom Export 
Wizard. 

 

 

 

 

 

 

3. In the wizard, select the desired script from the dropdown list. 
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4. Click Export to run the script.  
 
 

 

 

 

 

 

 

 

5. Once complete, a green confirmation message will appear stating “Export Successful” along with 
an option to open the export folder will be shown. 
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6. The resulting file will be saved to the path defined in the Export Path under Preferences. 
 

7. Click “Close” to exit the wizard. 
 

 

 

 

 

 

 

 

 

Note: Custom export scripts are grouped by item or result type. If a script is applied to an unsupported 

item, an error message will be displayed. 
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11 IMPORTING ITEMS INTO TDM 

TDM allows users to create item records by importing data from a formatted CSV file. This process is 

useful for loading multiple records at once, such as Meters, Cts, Vts, Meter Sites or EVSE Chargers. 

Follow the steps below to complete the import: 

6 Step-by-Step Instructions: 

1. From the Database menu, select “Import” to open the import screen. 

 

 

 

 

 

 

 

2. Select the type of items to import. The available items to import as Meters, Cts, Vts, Meter Sites 

or EVSE Chargers. After an item type has been set, the “GENERATE CSV TEMPLATE” button will 

be enabled. Users may now use this feature to create a CSV file template as basis or fill this file 

with item data. For this example, we are going to import meters.        
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3. Click “SELECT FILE” to browse and locate the csv file to be imported. 
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4. Once TDM finishes parsing the CSV file, a preview of the records to be imported will be 

displayed. A popup may appear with a warning if any fields are missing or left blank. TDM will 

automatically assign default values such as blanks, zeros, or “false” to those fields. Click “OK” to 

close the popup. 
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5. To proceed with saving these data into the database, click “SAVE IMPORTED ITEMS TO 

DATABASE” 

 
 

6. TDM will prompt you to confirm if any existing items with matching IDs should be overwritten 

with the new data. 

Click “Yes” to confirm and continue. 

 

 

 

 

 

 

 

 

 

 

 

 

7. Once the import is complete, TDM will notify the end user that the import was successful.   Click 

“OK” to close the popup. 
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8. Navigate to Database in the TDM side menu and click to expand the submenu. Then select 

“Items”.  Locate and select the item type you imported (e.g., Meters).  

The imported records will now be visible in the list.  

 

 

 

 

 

 

 

 

 

 

12 CONTROLLING A METER TEST BOARD REMOTELY 

TDM provides the ability to control and run tests on supported Meter Test Boards over the network. 

This functionality is available through the NextGen Testing interface. 

To begin, click “NextGen Testing” from the sidebar, then click “Manual Test”.  

IMPORTANT NOTE:  This option will only be available if “Meter Test Boards” is/was selected under 

Supported Devices in the Preferences popup.  If you don’t see it, refer to section 5.1, Setting Up 

Supported Devices. 
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12.1 Selecting a Meter Test Board to control 

On the Manual Test screen, click “Select Device” to open the device selector. 

 

The popup will display any Meter Test Boards currently discovered on the network. 

o If the device does not appear, return to the Devices page and perform a network scan. 

       

Select the desired device. 
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Click “Done” to close the popup. 

 

 

12.2 Setting Meter information & Service 

On the Manual Test screen, click “Drive/Unit Testing” above the NextGen Device ribbon. 

 

Under the Meter Info ribbon, set the Meter Form based on the meter currently installed in the socket 

on the Meter Test Board. 
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In the Drive Setup ribbon, use the Service dropdown to select the appropriate service for the test. 

 

 

12.3 Turning the Voltage and/or Current ON/OFF 

The Drive/Unit tab in Manual Test displays waveform setup fields for voltage, current, and phase. These 

fields may be edited to generate custom waveforms as needed. 

 

 

 

 

 

 

Click “Voltage On” to activate the voltage channels. Once turned on, the button will change to 

Voltage Off, which can be clicked to turn voltage off. 
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Click “Load On” to activate the current channels. Once active, the button will change to “Load Off”, 

which can be clicked to disable the current output. 

 

 

 

 

Click “Pulse Align (P.A.)” to begin detecting pulses from the connected meter. The button text will 

change to “Stop P.A”, which can be clicked to stop pulse detection and turn off the current 

channels. 
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Tip: Use these controls to simulate test conditions in real time without running a full test sequence.  
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13.  RUNNING A SINGLE TEST ON A METER TEST 

BOARD 

To perform a single test using a Meter Test Board, begin by navigating to the Manual Test page in TDM. 

Step-by-Step Instructions: 

1. Click the “Drive/Unit Testing” tab. 

2. Select the Meter Test Board that will run the test. 

3. Enter the appropriate meter information and select the service. 

4. Define the target waveform using the available voltage, current, and phase settings. 

 

 

Test Setup: 

• In the Test Parameters section, select the desired test type and update its parameters as 

needed. 

• Click “Start Test” to begin the test. 
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Monitoring and Results: 

• While the test is in progress, real-time information will be displayed in the Active Test Info 

section. 

                            

Upon completion, a summary of the results will appear in the Sequence Results section. 

                         

Recommendation: After completing the full test session, perform a Quick Sync to retrieve the test 

results from the device. 

To view the results, refer to the Viewing Results section (9.4) of this manual. 
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14.  RUNNING A SEQUENCE ON A METER TEST 

BOARD 

To run a predefined test sequence on a Meter Test Board, navigate to the Manual Test page in TDM. 

Step-by-Step Instructions: 

1. Click the “Sequence” tab. 

2. Select the Meter Test Board that will execute the sequence. 

3. Enter the required meter information for the test setup. 

                   

Sequence Configuration: 

• In the Sequence Parameters section, choose the appropriate service and sequence to be run on 

the selected device. 

                  

Running the Sequence: 

• Click “Start Sequence” to begin executing the test sequence on the Meter Test Board. 
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Monitoring and Results: 

• Real-time details of the active test will be shown in the Active Test Info section. 

              

• Once completed, a summary of the sequence will appear in the Sequence Results section. 

             

Recommendation: After the sequence has finished, perform a Quick Sync to retrieve test results from 

the device. 

For instructions on how to view test results, refer to the Viewing Results section (9.4) of this manual. 
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15. TAGS 

Tags provide a flexible way to organize and categorize records in TDM, such as Meters, CTs, VTs, Sites, 

and Chargers. Tags can be managed centrally and applied to items for sorting, filtering, and reference. 

15.1 Managing tags 

To manage tags, click “Tags” under the Management menu from the toolbar. This will open the Tag 

Management popup, displaying all available tags for supported item types. 

 

Available options include:  

1. Search: Use the search bar to filter tags by keyword. 

2. Add a Tag: Click the “Add” button in the lower-right corner to create a new tag. 

3. Rename a Tag: Select a tag and click “Rename” to update its name. 

4. Delete a Tag: Select a tag and click “Delete” to remove it from the system. 

Note: Tag names must be unique and cannot be reused after deletion. 

 

15.2 Using tags 

Currently, tags can be applied and managed on the Database > Items page found on the sidebar 

menu. 

 

 

 

 

 

1 

2 3 4 
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15.2.1  Assigning a tag to an item 

To assign an existing tag to an item: 

• Click the “+” button on the leftmost side of the item’s row. 

 

 

 

 

 

 

 

• Select a tag from the list. 

 

 

 

 

 

 

 

 

 

• A green tag widget will appear in the Tags column for that item. 
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15.2.2  Creating a tag and assigning it to an item 

To create and assign a new tag in one step: 

• Click the “+” button on the leftmost side of the item’s row. 

 

 

 

 

 

 

 

• Select “Add New”. 

 

 

 

 

 

 

 

 

• Enter the tag name and click “OK”. 

 

 

 

 

 

 

 

 

 

Lab only 
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• A green tag widget will be added to the Tags column for that item. 

 

 

 

 

 

 

15.2.3 Removing a tag from an item 

To remove a tag from an item: 

• Click the “×” icon next to the tag in the Tags column. 

• The tag will be removed from that specific item. 

 

 

 

 

 

 

 

 

15.2.4  Filter items using tags 

To filter the item list using tags: 

• Click “Select” under the Search section and choose a tag. 

• A green tag widget will appear in the tag filter list, and the table will refresh 

based on the selected filters. 
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To remove a tag filter: 

• Click the “×” icon next to the tag in the Search section. 

 

 

 

 

• The table will refresh automatically based on the remaining filters. 
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16.  CREATING/EDITING CUSTOM EXPORT SCRIPTS 

TDM allows users to build Custom Export Scripts to generate report files in formats that meet specific 
organizational or third-party requirements from selected records in either the Database Items or 
Database Test Results page.  

 
Performing Custom Export via Database Items table record selection 

These scripts are made up of two main components: a SQL query, which defines the data to be 
retrieved, and a Regular Expression, which formats the output. 

In most cases, users will only need to define the SQL portion, as the regular expression can be kept 
simple for standard formats. 

To create a new custom export script: 

• Click “Custom Export” under the Management menu. 

• Click “Add” to create a new script. 

• Enter a “name” for the script and proceed to define its components. 

16.1 SQL query 

• From the Select Target Data dropdown, choose the database table where the Custom 
Export will be usable. Click DB Schema to open a reference diagram showing the 
structure and relationships of available tables. 

• The Input parameter represents the type of data that can be extracted from the Target 
Data. It can either be ${serials}, representing the comma-separated list of serial 
numbers of the selected rows (see above) or ${resultKeys}, representing the comma-
separated list of result keys for test results.  

NOTE: The Input parameter should be used in the SQL query. 
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• Input your SQL query with the applicable Input parameter. As an example, below is a 
query with Meter table as the Target Data using the ${serials} Input parameter: 

SELECT meterSerial, meterForm FROM Meter WHERE meterSerial IN (${serials}) 
 
Upon query execution, the ${serials} parameter will be substituted by the selected serial 
numbers. As an example, using Figure 1 selections, the final query will be 
 
SELECT meterSerial, meterForm FROM Meter WHERE meterSerial IN (‘meter02’, 
‘meter01’, ‘meter02’, ‘meter01’, ‘6789’, ‘43t aef’) 

• For easy representation, the query result is converted into a comma-separated value 
(CSV format). This is important to keep in mind when extracting and formatting the final 
output using Regular Expressions. 

Note: Ensure your SQL query returns data in a format compatible with your export needs. Advanced 
users may incorporate JOINs, filters, and aliases as required.  
 
Note: Only SELECT (read-only) queries are allowed 

16.2 Regular Expression 

Regular Expression can be used to extract (capture) data from the CSV data of the SQL query, and to rearrange 

them freely. 

Suggested Steps: 

1. After entering your SQL query, click Next button. 

2. You may tick Include Headers from CSV Results checkbox if you want to include query columns 

from the CSV data. 

3. Click Add RegEx button to add as many regular expression definitions as necessary. 

RegEx field: This is the actual regular expression. At least one capture should be included in the 

expression. 

Format field: This is the format of the exported data using the regular expression captures. 

Captures are represented by ${1} for capture 1, ${2} for capture 2, so on and so forth. 
 

Description field: This is the description of the regular expression, the format, or anything that 

relates to the regular expression definition. This field is optional. 

 

As an example, below is regular expression definition that includes the CSV Header from the 

example query above and the resulting export output: 
 

SQL Result (CSV-formatted): 
 meterSerial,meterForm 

 meter02,2 
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 meter01,2 

 : 

 43t aef,9 

Regular Expression Definition: 

 RegEx: ^(.*),(.*)$ 

 Format: ${2}:${1} 

 Description: Extract 2 data between commas, reverse order and join them with a colon 

 

Export Output: 
 meterForm:meterSerial 

 2:meter02 

 2:meter01 

 : 

 9:43t aef 

NOTE: For Custom Exports with more than one regular expression definitions, the output of the 

first will be fed to the next one and so on and so forth until the last definition is performed. 

NOTE: All Regular Expression should follow the Perl-compatible format. 

  

16.3 Regular Expression for Header 

Regular Expression Header can be used to replace the original CSV header row from the 

SQL query results with a custom header. This allows you to standardize or rename columns freely for the 

exported data.  

Suggested Steps:  

1. After entering your SQL query, click “Next” button.  

2. Click “Add RegEx” Header button to define a header override.  

3. In the RegEx field, enter a pattern to capture the header row (e.g., ^(.*)$).  

4. In the Format field, define the new header row. The captured original header can be ignored if 

not needed.  

5. Optionally, enter a description for the RegEx Header override.  

RegEx Header Fields:  

• RegEx field: This is the regular expression to capture the original header. At least one capture 

group should be included.  

• Format field: This is the new header row for export. Use ${1}, ${2}, etc., if you want to include 

captured values, or ignore captures to fully override.  

• Description field: Optional text to describe the purpose of the header override.  
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NOTE:  

• This operation applies only to the header row; data rows are not affected.  

• If multiple header overrides are used, they are applied sequentially, with each override replacing 

the previous result.  

 

16.4 File name and file format 

This section determines how the exported file will be named and what format it will use when 

saved. 

 Suggested Steps: 

1. In the Filename Format text field, type the desired file name format which can include fixed and 

generated sections. To include a generated data like date/timestamp in the filename, the 

<DateTimeStamp> placeholder can be used. See Filename Format Parameters section for a list 

of available generated data with their corresponding descriptions. 

2. In the File Extension text field, type the desired file extension (without the dot). This can be any 

known extension like csv, json or a custom one like dat. 

As an example, the following Filename Format value of 
              Exportedby_<username>_on_<DateTimeStamp> 

with a File Extension of  
              frt 

will yield a file 
              Exportedby_TESCO_on_20250407_160817.frt  

assuming that the logged in username is TESCO and the export was generated on April 7th, 2025, at 

04:08:17 pm. 

16.5 Output Directory 

This section sets the location where the Custom Export file will be saved. By default, it will use the 

Export Path in the Preferences if left unchanged. 

 

 

 

 

 

 

http://www.tescometering.com/


 

 

 

     121 

Installation Guide 

     tescometering.com         +1 215 228 0500 

               support@tescometering.com 

17.  CUSTOM SQL QUERIES 

17.1 Creating Custom SQL queries 

This feature allows users to define ad-hoc SQL queries to extract data from the TDM database for 

analysis, validation, or custom reporting. 

Suggested Steps: 

1. Navigate to Management > Custom SQL. 

2. Click Add Query and enter a name for your custom query. 

3. Enter your SQL query in the editor field. 

Query Parameters can be inserted anywhere in the SQL query to allow input of query details 
through a popup. This is useful to make the query more flexible.   
As an example, below is a query that searches for specific records from the Meter table based 
off a meter serial list using the query parameter ${Meter Serials} to get that list from the user.  
SELECT * from Meter where meterSerial IN (${Meter Serials})  
 

                                                                                     

 

 

 

 

The query parameter value is then substituted to the original query making it  

SELECT * from Meter where meterSerial IN (‘abc’)  

4. Click “PROCEED” to store the query for future use. 

Note: Use the DB Schema button to view available fields and relationships between tables. 

17.2 Running Custom SQL queries 

To execute a previously created custom query: 

1. Navigate to Management > Custom SQL. 

2. Select the desired query from the list. 

3. Click Run to execute the SQL command. 

4. Results will be displayed in a table format within the interface. 

Optional: Export the query results using the Export to CSV button. 
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18.  CHANGELOG 

This section provides a detailed record of manual revisions, including software updates, procedural 

adjustments, and any other relevant information you may want to track. 

Date Author Log 
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19.  TECHNICAL SUPPORT 

Technical Support Contact Information: 

For any technical issues, questions about TDM, you can reach TESCO through the following: 

• Phone (Technical Support): +1 (215) 228-0500  

This is TESCO’s main support line.  

Hours of operation are Monday – Friday, 7:00 AM – 6:00 PM (Eastern Standard Time). 

• Email: support@tescometering.com 

Email is great for non-urgent inquiries or to send a detailed description of an issue (even screenshots). 

TESCO’s support team monitors this address and typically responds within one business day. 

When contacting support, always provide the following information to ensure efficient assistance: 

• The current firmware or software version, if known 

• A concise description of the issue, including any error codes and/or system behavior. 

 

Thank you for your patronage, we look forward to working with you! 

-The TESCO Team 
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